ABSTRACT: Authors of papers to proceedings have to type these in a form suitable for direct photographic or digital reproduction by the publisher. In order to ensure uniform style throughout the volume, all the papers have to be prepared strictly according to the instructions set below. A laser printer should be used to print the text. The final output of this document will be reduced to 85% by the publisher and will be printed by him in black only. For the convenience of the authors a template file for MS Word 6.0 (and higher) is provided.

1 GENERAL INSTRUCTIONS

1.1 Type area
The text should fit exactly into the type area (150 × 240 mm). For A4 size paper the margin settings are: Top: 2.5 cm; Bottom: 3.0 cm; Left: 3.0 cm; Right: 3.0 cm; and all other settings 0.00 cm (template file: A4temp.dot). For Letter size paper these settings are: Top: 0.69"; Bottom: 0.79"; Left: 1.29"; Right: 1.29"; and all other settings 0.00" (template file: UStemp.dot).

1.2 Typefont, typesize and spacing
Use *Times New Roman*, point-size 11 and 12 points line spacing (Standard;text tag). Use roman type except for the headings (Heading tags), parameters in mathematics (not for log, sin, cos, ln, max., d (in dx), etc), Latin names of species and genera in botany and zoology and the titles of journals and books which should all be in italics. Never use **bold**, except to denote vectors in mathematics. Never underline any text. Use the small font (10 points on 11 points) for tables (Table tags), figure captions (Figure caption tag) and the references (Reference text tag). Never use letter spacing and never use more than one space after each other.

2 GETTING STARTED

2.1 The template file
Copy the template file A4temp.dot (if you print on A4 size paper) or UStemp.dot (for Letter size paper) to the template directory. This directory can be found by selecting the Tools menu, Options and then by tabbing the File Locations. When the Word programme has been started open the File menu and choose New. Now select the template A4temp.dot or UStemp.dot (see above). Now start by renaming the document by clicking Save As in the menu Files.

2.2 Title, author and affiliation frame
Place the cursor on the T of Title at the top of your newly named file and type the title of the paper in lower case (no caps except for proper names). The title should not be longer than 75
characters). Delete the word Title (do not delete the paragraph end).

Place the cursor on the A of A.B. Author(s) and type the name of the first author (first the initials and then the last name). If any of the co-authors have the same affiliation as the first author, add his name after an & (or a comma if more names follow). Delete the words A.B. Author etc. and place the cursor on the A of Affiliation. Type the correct affiliation: Name of the institute, City, State/Province, Country, do not add street names, P.O. Box numbers or zip codes to the affiliations. Now delete the word Affiliation. If there are authors linked to other institutes, place the cursor at the end of the affiliation line just typed and give a return. Now type the name(s) of the author(s) and after a return the affiliation. Repeat this procedure until all affiliations have been typed.

All the above texts should fit in the frame which should not be changed (Width: Exactly 15.0 cm or 5.91"; Height: Exactly 7.2 cm or 2.79"; Lock anchor).

2.3 Abstract frame

If there are no further authors place the cursor one space behind the word ABSTRACT: and type your abstract of not more than 150 words. The first line of the abstract will be 7.2 cm (2.83") from the top. The complete abstract will fall in the abstract frame, the settings of which should also not be changed (width: Exactly 15.0 cm or 5.91"; height: Automatic; vertical: 7.2 cm or 2.83" from margin; Lock anchor).

2.4 First line of text or heading

If your text starts with a heading, place the cursor on the I of INTRODUCTION and type the correct text for the heading. Now delete the word INTRODUCTION and start with the text after a return. This text should have the tag First paragraph.

If your text starts without a heading you should place the cursor on the I of INTRODUCTION, change the tag to First paragraph and type your text after deleting the word INTRODUCTION, but not the return at the end.

3 LAYOUT OF TEXT

3.1 Text and indenting

All text, figures, tables, etc. should fit exactly in the type area of 15 × 24 cm (5.91" × 9.52"). All text should be typed in Times New Roman. All text is 11 pt on 12 pt line spacing except for the paper title (16 pt on 18 pt), author(s) (12 pt on 13 pt), affiliation(s) (10 pt on 11 pt) and the small text in tables, captions and references (10 pt on 11 pt). All line spacing is exact. Never add a line space between lines or paragraphs.

First lines of paragraphs are indented 4 mm (0.16") except for paragraphs after a heading or a blank line (First paragraph tag). Equations are indented 12 mm (0.47") (Formula tag).

3.2 Headings

Type primary headings in capital letters roman (Heading 1 tag) and secondary and tertiary headings in lower case italics (Headings 2 and 3 tags). Headings are set flush against the left margin. The tag will give two blank lines (24 pt) above and one (12 pt) beneath the primary headings, ½ blank lines (18 pt) above and a ½ blank line (6 pt) beneath the secondary headings and one blank line (12 pt) above the tertiary headings. Headings are not indented and neither are the first lines of text following the heading indented. If a primary heading is directly followed by a secondary heading, only a ½ blank line should be set between the two headings. In the Word programme this has to be done manually as follows: Place the cursor on the primary heading, select Paragraph in the Format menu, and change the setting for spacing after, from 12 pt to 0 pt. In the same way the setting in the secondary heading for spacing before should be changed from 18 pt to 6 pt.
3.3 **Listing and numbering**
When listing facts use either the style tag List summary signs or the style tag List number signs.

3.4 **Equations**
Use the equation editor of the selected word processing programme. Equations are indented 12 mm (0.47”) from the left margin (Formula tag). Number equations consecutively and place the number with the tab key at the end of the line, between parentheses. Refer to equations by these numbers. See for example Equation 1 below:

\[
\sigma_y(L_0) = \sigma_y(L_{01}) \left( \frac{L_0}{L_{01}} \right)^{1/\alpha_{w_{01}}}
\] (1)

3.5 **Tables**
Locate tables close to the first reference to them in the text and number them consecutively. Avoid abbreviations in column headings. Indicate units in the line immediately below the heading. Explanations should be given at the foot of the table, not within the table itself. Use only horizontal rules: One above and one below the column headings and one at the foot of the table (Table rule tag: Use the Shift-minus key to actually type the rule exactly where you want it). For simple tables use the tab key and not the table option. Type all text in tables in small type (Table text tag). Align all headings to the left of their column and start these headings with an initial capital. Type the caption above the table to the same width as the table (Table caption tag). See for example Table 1.

<table>
<thead>
<tr>
<th>Phase</th>
<th>Frequency (Hz)</th>
<th>Standard deviation</th>
<th>Change (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Frequency</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phase 1</td>
<td>5.91</td>
<td>0.16</td>
<td>0.85</td>
</tr>
<tr>
<td></td>
<td>8.80</td>
<td>0.28</td>
<td>0.80</td>
</tr>
<tr>
<td></td>
<td>13.08</td>
<td>0.21</td>
<td>-0.15</td>
</tr>
<tr>
<td></td>
<td>16.90</td>
<td>0.15</td>
<td>-0.17</td>
</tr>
<tr>
<td>Phase 2</td>
<td>6.29</td>
<td>0.22</td>
<td>7.34</td>
</tr>
<tr>
<td></td>
<td>8.58</td>
<td>0.11</td>
<td>-1.72</td>
</tr>
<tr>
<td></td>
<td>13.15</td>
<td>0.30</td>
<td>0.38</td>
</tr>
<tr>
<td></td>
<td>17.30</td>
<td>0.15</td>
<td>2.18</td>
</tr>
<tr>
<td>Phase 3</td>
<td>6.35</td>
<td>0.11</td>
<td>8.36</td>
</tr>
<tr>
<td></td>
<td>8.54</td>
<td>0.28</td>
<td>-2.17</td>
</tr>
<tr>
<td></td>
<td>13.36</td>
<td>0.28</td>
<td>1.98</td>
</tr>
<tr>
<td></td>
<td>16.78</td>
<td>0.23</td>
<td>-0.88</td>
</tr>
<tr>
<td>Phase 4</td>
<td>6.50</td>
<td>0.13</td>
<td>10.92</td>
</tr>
<tr>
<td></td>
<td>8.48</td>
<td>0.27</td>
<td>-2.86</td>
</tr>
<tr>
<td></td>
<td>13.64</td>
<td>0.23</td>
<td>4.12</td>
</tr>
<tr>
<td></td>
<td>17.39</td>
<td>0.19</td>
<td>2.72</td>
</tr>
</tbody>
</table>

3.6 **Figure captions**
Always use the Figure caption style tag (10 points size on 11 points line space). Place the caption underneath the figure (see Section 5). Type as follows: ‘Figure 1. Caption.’ Leave about two lines of space between the figure caption and the text of the paper.

3.7 **References**
In the text, place the authors’ last names (without initials) and the date of publication in parentheses (see examples in Section 7). At the end of the paper, list all references in alphabetical order underneath the heading REFERENCES (Heading without number tag). The references should be typed in small text (10 pt on 11 pt) and second and further lines should be indented 4.0 mm (Reference text tag). If several works by the same author are cited, entries should be chronological.
In bibliographies the order for books and journals are respectively:
Last name, First name or Initials (ed.) year. Book title. City: Publisher.
Last name, First name or Initials year. Title of article. Title of Journal (series number if necessary) volume number (issue number if necessary): page numbers.

3.8 Notes
These should be avoided. Insert the information in the text. In tables the following reference marks should be used: *, **, etc. and the actual footnotes are set directly underneath the table.

3.9 Conclusions
Conclusions should state concisely the most important propositions of the paper as well as the author’s views of the practical implications of the results.

4 PHOTOGRAPHS AND FIGURES

Number figures consecutively in the order in which reference is made to them in the text, making no distinction between diagrams and photographs. Figures should fit within the type area width of 150 mm (5.91").

Figures, photographs, etc. should be in black only. Paste same size copies onto the typescript where you want them to appear in the text. Do not place them sideways on a page; however if this cannot be avoided, no other text (except the figure caption) should appear on that page. Figures, etc. should not be centered, but placed against the left margin. Leave about two lines of space between the actual text and figure (including caption). Never place any text next to a figure. Leave this space blank. The most convenient place for placing figures is at the top or bottom of the page. Avoid placing text between figures as readers might not notice the text. Line drawings (as well as photographic reproductions of these) should be in black (not grey) on white. The minimum size of the lettering should be 9 point. Lines should preferably be 0.2 mm (0.1") thick. Keep figures as simple as possible. Avoid excessive notes and designations.

Photographs should be black and white, with good contrast and on glossy paper. Photographic reproductions cut from books or journals, photocopies of photographs and screened photographs are unacceptable. The proceedings will be printed in black only. For this reason avoid the use of colour in figures and photographs. Colour is also nearly always unnecessary for scientific work.

Figure 1. Caption of a typical figure.
5 PREFERENCES, SYMBOLS AND UNITS

Consistency of style is very important. Note the spacing, punctuation and caps in all the examples below.
- References in the text: Figure 1, Figures 2-4, 6, 8a, b (not abbreviated)
- References between parentheses: (Fig. 1), (Figs 2-4, 6, 8a, b) (abbreviated)
- USA / UK / Netherlands / the Netherlands instead of U.S.A. / U.K. / The Netherlands
- Author & Author (1989) instead of Author and Author (1989)
- (Author 1989a, b, Author & Author 1987) instead of (Author, 1989a,b; Author and Author, 1987)
- (Author et al. 1989) instead of (Author, Author & Author 1989)
- Use the following style: (Author, in press); (Author, in prep.); (Author, unpubl.); (Author, pers. comm.)

Always use the official SI notations:

6 SUBMISSION OF MATERIAL TO THE EDITOR

The camera-ready copy of the complete paper printed on a high resolution printer on one side of the paper as well as two copies of the paper should be sent to the editor. Include the original photographs. Check whether the paper looks the same as this sample: Title at top of first page in 16 points, all other text in 11 points on 12 points line space, except for the small text (10 point on 11 point line space) used for the affiliations of the authors, and in tables, captions and references. Also check if the type width is 150 mm and the page length is 240 mm. Write your name and the short title of the paper in pencil in the bottom margin of each page and number the pages correctly. This material should be with the editor before the deadline for submission. Any material received too late will not be published. Send the material by airmail or by courier well packed and in time. Be sure that all pages are included in the parcel.
Paper title

A.B. Author, C. Auteur & D.E. Author
Affiliation

ABSTRACT:

1 INTRODUCTION
First line of second page

Last line of second page